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DARKADAPTED SOFTWARE LICENSE
Before opening DarkAdapted, carefully read the following License Agreement. Opening DarkAdapted indicates your acceptance of the terms and conditions of this Agreement. 
If you do not agree to abide by the terms and conditions of this Agreement, promptly return the product to the place of purchase, and your money will be refunded.

A. License. The software accompanying this License (the “Software”) and the related documentation are licensed to you by Stephen E. Hutson. You own the media on which 
the Software is recorded, if applicable, but Stephen E. Hutson retains title to the Software and all related documentation.

This License allows you to use the Software on a single computer and make up to ten (10) copies of the Software in machine-readable form for backup purposes only. You 
must reproduce on such copy the copyright notice and any other proprietary legends that were on the original copy of the Software. You may transfer all your license rights 
in the Software, the backup copies of the Software, the related documentation and a copy of this License to another party, provided the other party reads and agrees to accept 
the terms and conditions of this License, and provided you destroy all copies of the Software in your possession prior to license transfer.

B. Restrictions. The Software contains copyrighted material, trade secrets, and other proprietary material, and in order to protect them, you may not decompile, reverse engi-
neer, disassemble, or otherwise reduce the Software to a human-perceivable form. You may not modify, network, rent, lease, loan, distribute, or create derivative works based 
upon the Software in whole or in part. You may not electronically transmit the Software from one computer to another over a network.

C. Termination. This License is effective until terminated. You may terminate this License at any time by destroying the Software and related documentation and all copies 
thereof. This License will terminate immediately without notice from Stephen E. Hutson if you fail to comply with any provision of this License. Upon termination, you must 
destroy the Software and related documentation and all copies thereof.

D. Exporting. You agree and certify that the Software, its related documentation, nor any copies thereof will be exported outside of the United States except as authorized and 
as permitted by the laws and regulations of the United States of America.

E. Limited Warranty on Media. Stephen E. Hutson warrants the media on which the Software is recorded, if applicable, to be free from defects in materials and workmanship 
under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of the receipt. Stephen E. Hutson’s entire liability and exclusive remedy 
will be the replacement of the media not meeting this limited warranty and which are returned to Stephen E. Hutson with a copy of the receipt. Stephen E. Hutson will have 
no responsibility to replace media damaged by accident, abuse, or misapplication. ANY IMPLIED WARRANTIES ON THE MEDIA, INCLUDING THE IMPLIED WARRAN-
TIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE 
DATE OF DELIVERY. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION.

F. Disclaimer of Warranty of Software. You expressly acknowledge and agree that use of the Software is at your sole risk. THE SOFTWARE AND RELATED DOCUMENTA-
TION ARE PROVIDED “AS IS” AND WITHOUT WARRANTY OF ANY KIND AND STEPHEN E. HUTSON EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR 
PURPOSE. STEPHEN E. HUTSON DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT 
THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, 
STEPHEN E. HUTSON DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION 
IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN ADVICE OR INFORMATION GIVEN BY STEPHEN E. 
HUTSON OR ITS REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLU-
SION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

G. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL STEPHEN E. HUTSON OR ITS DIRECTORS, OFFICERS, EMPLOYEES, OR 
AGENTS, BE LIABLE FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES THAT RESULT FROM THE USE OR INABILITY TO USE THE SOFTWARE 
OR RELATED DOCUMENTATION, EVEN IF IT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE LIMI-
TATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO 
YOU.

In no event shall Stephen E. Hutson’s total liability to you for all damages, losses, and causes of action (whether in contract, tort [including negligence], or otherwise) exceed 
the amount paid by you for the Software.

H. Controlling Law and Severability. This License shall be governed by and construed in accordance with the laws of the United States and the State of Illinois.
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Section 1:  
Introduction

 DarkAdapted can dim your screen to the point that it becomes 
unreadable! If this occurs, the default escape sequence is  SHIFT

CONTROL OPTION / ALT , which will return your screen to full bright-
ness.

1.1 — License Agreement
Before using DarkAdapted, carefully read the enclosed Software License 
Agreement. If you do not agree with any provision of this agreement, do not 
use DarkAdapted, and delete all copies of the program. Using DarkAdapted 
indicates your acceptance of the Software License Agreement.

DarkAdapted is freeware, but remains a copyrighted program. Distribution 
of DarkAdapted must include this User Guide and all other documentation.

1.2 — What is DarkAdapted?
DarkAdapted is a gamma control application program. It modifies the red, 
green, and blue components of your screen gamma so that you may, for 
example, preserve your dark adaptation while using your computer.

DarkAdapted boasts such features as:

•  Includes the same powerful screen adjustment technology as 
ScopeDriver, a full featured telescope control program.

•  Customizable gamma presets. Use predefined settings, create your 
own, and manipulate your presets with ease.

•  High-resolution sliders allow you to adjust red, green, and blue video 
components individually and in real time.

•  Set red, green, and blue video components via the keyboard, and 
toggle between entering percentages and raw gamma values.

•  Small screen mode hides advanced controls, minimizing the use of 
valuable screen real estate.

•  Gamma toggle keys offer quick switching between full brightness and 
the most recent gamma setting. Modifier keys are full assignable, and 
are available system-wide.

•  Switching to gamma presets is performed via smooth fades, never 
abrupt shifts in screen color or brightness.

•  Control console “remembers” its position on your screen in both its 
minimized and maximized modes.

•  Saved gamma preset is restored when DarkAdapted is launched, and 
reset when DarkAdapted quits.

•  Useful display features show gamma changes’ effects on selected text, 
as well as text on different backgrounds.

•  Useful numeric and graphical readouts of gamma values.
•  In multiple monitor setups, DarkAdapted controls all displays in 

unison.
•  Automatic and/or manual Internet update checking ensures you have 

the latest version.
•  And many other time savers and productivity enhancers.

Additional features available in DarkAdapted Pro (available for Macintosh 
only) include:

•  System-wide Status Item Menu offers control of virtually every 
DarkAdapted setting.

•  System-wide hotkeys allow setting brightness, gamma values, presets, 
and much more via a customizable key combination.

•  Global hotkeys for adjusting the screen brightness.
•  Independent control windows for multiple display setups.
•  Scheduled gamma fades by day of week, time, and/or sunrise and 

sunset.
•  Preset Sets, which can implement gamma fades for multiple screens 

simultaneously with a single command or hotkey.
•  Run Applescripts from the system-wide menu, or at the touch of a 

hotkey.
•  Automatic launch at login for one or all users.
•  Shared or individual preferences for all users.
•  Define a minimum brightness for all displays.
• Scroll wheel support for slider motion and Presets: pop-up menu.
• Expanded Applescript support.
•  And much more!

1.3 — System Requirements
DarkAdapted requires the following hardware setup:

•   Mac: Intel Macintosh or Power Macintosh.
•  Windows: PC capable of running Windows 95 or later.
•  At least 4 MB available RAM (6 MB recommended).
•  At least 2 MB available hard disk space.
•  Windows: Compatible monitor and video card.
•  Mac: Mac OS X: 10.2 or later.
•  Windows: Windows 95 or later.

http://www.adpartnership.net/ScopeDriver/index.html
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1.4 — Special Thanks
Special thanks to my wife, Nancy, who put up with endless DarkAdapted 
demonstrations. :-)

1.5 — Trademark Information
All trademarks referenced herein are property of their respective owners.

1.6 — Guide Layout
 This symbol references features or behavior specific to Macintosh 
computers. Such items are not applicable to IBM-compatible PC’s.
 When you see this symbol, the manual discusses features or behav-
ior specific to IBM-compatible computers. Such items do not apply 
to Macintosh computers.
 This symbol denotes features relevant only to DarkAdapted Pro, 
which operates only on the Macintosh platform.

Throughout this User Guide, menu selections and menu titles are depicted 
using the following typeface: Menu Title

Keyboard equivalents are shown using the Macintosh command-key symbol, 
along with the modifier key(s). For example, S  means that you hold down 
the  (command) key while typing the letter S . 

 If you are using DarkAdapted for Windows, substitute the CONTROL  
key for the  key.
 If a keyboard equivalent with no menu counterpart doesn’t seem 
to be working, simply add the SHIFT  key to implement the action. 
This is necessary because Windows doesn’t allow window key-
board shortcuts that override menu keyboard shortcuts, even 
when the menu is disabled.

Window names appear in boldface, as in Main Window.

DarkAdapted has been designed with ease of use in mind. Any features of 
the program not covered in this brief guide are, hopefully, self-explanatory. 
Your suggestions for improvement are always welcome!

1.7 — Connecting to Our Web Site
Clicking the web address in the Main Window will launch your browser and 
attempt to connect to the DarkAdapted web site. This will work only if you 
have defined a default browser using your system software. 

Section 2:  
Installation and Setup

2.1 — Installation
To install DarkAdapted and its documentation, you’ll follow the below pro-
cedure. You must have at least 12 megabytes of free hard drive space.

 Locate and mount the Macintosh disk image. The disk image will 
contain a folder which contains the DarkAdapted application pro-
gram, documentation, and extras.
 Open the DarkAdapted folder, then double-click the file entitled 

“Read Me.” Read this document, which may contain late-breaking 
information or special instructions.
 Double-click on the DarkAdapted application program icon, and 
follow the instructions on screen.
 Locate and decompress the downloaded archive. The expanded 
folder contains the DarkAdapted application program and its 
documentation.
 Drag the DarkAdapted Folder to the desired location.
 Open the DarkAdapted folder, then double-click the file entitled 

“Read Me.” Read this document, which may contain late-breaking 
information or special instructions.
 Double-click on the icon entitled “DarkAdapted.exe.” If you do not 
have the correct application file for your operating system, check 
the DarkAdapted web site for the correct file.

http://www.adpartnership.net/DarkAdapted/index.html
http://www.adpartnership.net/DarkAdapted/index.html
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2.2 — First Run
Double-click on the icon representing the DarkAdapted application. The 
Control Window will then appear, as depicted below:

Control Window

Note the text that appears below the Presets: pop-up menu. These are the 
keys that you must hold down to return to full screen brightness, in the 
event that your adjustments result in a monitor that’s too dark to read. Press 
these keys once to return to full brightness, and again to return to the previ-
ous gamma setting.

 The default gamma toggle keys on the Mac platform are 
SHIFT  RETURN  (although they may be changed in the Preferences 

Window). All of these keys must be held down simultaneously.
 The default Windows gamma toggle keys are CONTROL  SHIFT  

RETURN  (changeable via the Preferences Window). All of these 
keys must be held down simultaneously. 

 DarkAdapted Pro can present multiple Control Windows, with 
each window appearing on a different screen. In this mode, the 
gamma toggle keys may apply to whichever main window 
appears in front, or to all windows, as set in the DarkAdapted 
Preferences Window.

The gamma toggle keys may also be used to toggle between full brightness 
and the most recently selected gamma values. Simply release and again press 
the gamma toggle keys to toggle between the two states.

 To configure DarkAdapted Pro at the Control Window, right-click 
(or CONTROL -click) in a non-control area of the window, and a con-
textual menu opens with the choices DarkAdapted Preferences…, 
Show System-wide Menu… (in DarkAdapted Pro only), and Quit 
DarkAdapted.

2.3 — Try DarkAdapted Pro for Free
 DarkAdapted Pro is only available to users running DarkAdapted 
on a Macintosh; it is not available on Windows, owing to gamma 
control limitations on this platform.

To try DarkAdapted Pro’s advanced features, select Try DarkAdapted Pro… 
from the Special menu, as illustrated below:

“Try DarkAdapted Pro…” Menu Item

DarkAdapted Pro offers several additional features over the basic program, 
including:

•  A system-wide Status Item Menu, from which you may select Presets, change 
brightness, control RGB values, and control virtually every DarkAdapted 
setting.

•  Automatic launching of DarkAdapted at login, for the current user or all 
users.
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•  System-wide hotkeys, which allow setting brightness, gamma values, pre-
sets, and any other item in the Status Item Menu via global key combina-
tions.

•  Global, repeating hotkeys to adjust screen brightness in selectable incre-
ments.

•  The ability to share DarkAdapted preferences between all users of the same 
computer, if desired.

•  The ability to control multiple displays independently, using a separate 
Control Window for each display.

•  The option of creating Preset Sets, which can implement gamma fades for 
multiple screens simultaneously with a single command or hotkey.

•  Scheduling capabilities, including defining events that change gamma val-
ues on particulars days of the week, at certain times, and/or at sunrise or 
sunset. Scheduled events may control all displays and/or a single display.

•  Scroll wheel support for the Presets pop-up menu and the gamma sliders. 
In the case of the gamma sliders, scroll wheel control moves the sliders in 
unison, and offers the option to either preserve or ignore relative gamma 
intensities. In contrast, selecting Gang Sliders only offers the option to pre-
serve relative gamma intensities.

•  A system-wide Applescript menu that can execute Applescripts via the 
menu, or via user-defined, global hotkeys. 

•  Enhanced Applescript support to support the additional features of 
DarkAdapted Pro.

•  And much more.

After you select Try DarkAdapted Pro… from the Special menu, the following 
dialog appears:

Try DarkAdapted Pro Dialog

Select Try to enable all of DarkAdapted Pro’s enhanced features for a period 
of ten minutes, or click Cancel to continue using DarkAdapted in standard 
mode.

After ten minutes, DarkAdapted Pro reverts to standard mode, and pres-
ents a dialog allowing you to register, as described below in Registering 
DarkAdapted Pro.

If you’d like to try DarkAdapted Pro for another ten minutes, simply select  
Try DarkAdapted Pro… from the Special menu again, as often as you wish.

2.4 — Registering DarkAdapted Pro
 DarkAdapted Pro is only available to users running DarkAdapted 
on a Macintosh; it is not available on Windows, owing to gamma 
control limitations on this platform.

After you have launched DarkAdapted a few times, the Register DarkAdapted 
Pro window appears, as illustrated below:

Register DarkAdapted Pro Window

You may also summon the above window at any time by selecting Register 
DarkAdapted Pro… from the Special menu.
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To immediately obtain a serial number and begin using DarkAdapted Pro’s 
advanced features, connect to the Internet if necessary, then click the Upgrade 
button. You will be directed to our secure web site, where you may immedi-
ately obtain a serial number.

 Clicking the Upgrade button takes you to our secure online store, 
and provides you with a serial number immediately. If you would 
prefer to use PayPal, hold down the SHIFT  key while clicking 
Upgrade, and you will be directed to our web page where you have 
the option of paying via PayPal.

Copy the serial number from your order confirmation screen, then click 
the Paste Serial Number button to enter it into the Serial Number: text field. 
Alternatively, you may click to select the Serial Number: text entry field, then 
type your registration code.

Once a valid serial number has been entered, the Activate button becomes 
operational, and you may click it to complete the upgrade process. All of 
DarkAdapted Pro’s features will then be enabled.

Other choices in the Register DarkAdapted Pro window include the Try 
DarkAdapted Pro... button, which performs the same function as the menu 
command discussed in the section Try DarkAdapted Pro for Free.

The Don’t Remind Me button dismisses the Register DarkAdapted Pro win-
dow so that it shouldn’t appear again in the present version of DarkAdapted, 
and the Remind Later button postpones the window until the next time 
DarkAdapted is opened.

2.5 — Selecting a Preset
DarkAdapted includes several built-in presets, selectable via the Presets: pop-
up menu, as depicted below.

The Presets Pop-up Menu

When a preset is selected, the screen fades to the selected gamma setting. A 
preset set is a special type of preset that can control multiple displays, and is 
a DarkAdapted Pro feature described in Preset Sets.

 The most recent preset selected may be restored when you next 
launch DarkAdapted, by changing the appropriate setting in the 
Preferences Window.

 You may define global hotkeys for any preset, so that the preset can 
be accessed from anywhere on your computer, no matter which 
application program is in front. Setting hotkeys is described in 
System-wide Menu Hotkeys.

Any preset in the Presets: pop-up menu may also be selected via the keyboard 
whenever a Control Window is frontmost. In the below illustration, the text 
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orange has been typed on the keyboard, and so appears above the Presets: 
pop-up menu:

Miscellaneous Options — Preferences Window

DarkAdapted will then automatically display the first preset in the Presets: 
pop-up menu beginning with the text you type. For example, typing ora 
would select a preset named Orange, if that is the first preset in the menu 
beginning with the three letters ora.

 Typing a single SPACE  character will toggle between Full 
Brightness and the last selected gamma setting.

If no entries in the Presets: pop-up menu begin with the text you typed, noth-
ing is selected from the menu, and the text you typed will clear from the 
display after a one-second delay.

The BACKSPACE  key will delete the last character typed.

 Typed entries normally select a matching preset one second after 
you type the last character. To select the matching preset immedi-
ately, press the RETURN  or ENTER  key after typing the preset’s name.

 DarkAdapted Pro users may position the cursor over the Presets: 
pop-up menu and change the selected preset by using the scroll 
wheel on the mouse.

 The Presets: pop-up menu automatically changes to reflect any 
preset that matches the state of the gamma sliders. So, if you have 
defined a preset named Gray that consists of red, green, and blue 
values of 70% each, the Presets: pop-up menu will automatically 
switch to Gray when you again move all three sliders to 70%. 

2.6 — Showing Additional Detail
When first launched, DarkAdapted displays its Control Window with all of 
its controls and explanatory text. To display the full (maximized) Control 

Window at any time, click to select the checkbox control entitled Show Details 
to reveal additional controls and displays, as shown below.

Expanded Control Window

The three slider controls control the primary colors red, green, and blue 
— and they are labeled with the first letter of each color’s name. To the right of 
each control is displayed the actual gamma value of the corresponding color, 
which by default show the current gamma percentage for each primary color. 
You may change the readouts to instead display the actual gamma value 
(between 0 and 255) in the Preferences Window.

Click and drag any slider to change its gamma value.

The four regions near the bottom of this window reveal the results of your 
gamma adjustments. The text field at lower left displays both selected and 
normal text; the remaining displays show both black text and white text on 
backgrounds that correspond to the three primary colors. 

 These display regions are useful in determining whether your 
changes may render text or graphics unreadable under certain 
circumstances.

 DarkAdapted Pro users may position the cursor over the gamma 
sliders and move the sliders in unison by using the scroll wheel on 
the mouse.
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2.7 — Showing Less Detail
Click to deselect the Control Window’s Show Details control to minimize the 
Control Window, as depicted below:

Minimized Control Window

When minimized, the Control Window occupies much less screen area, hid-
ing the text displays, the gamma sliders, and the text which reminds you 
which gamma toggle keys will restore the screen to full brightness.

 DarkAdapted “remembers” the Control Window’s position inde-
pendently for both its expanded and minimized states. This allows 
you to preserve one desired screen position for the expanded 
Control Window, and a different screen position for when the 
window is minimized.

2.8 — Ganged Sliders
By default, DarkAdapted allows independent control of each gamma channel 
(red, green, and blue). To instead move the sliders in unison, click to select the 
Gang Sliders control in the Control Window, as depicted below:

Ganged Sliders Mode

Ganged slider mode preserves the relative red, green, and blue values, until 
one or more sliders reaches the end of its travel, then the relative values are 
discarded. For example, if you start with the following gamma values:
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…and then slide the Red slider left toward 20%, the Green and Blue sliders 
will follow along, stopping at 0%, since no slider can go below 0%, as shown 
below:

But when you return the Red slider to 80%, note that the Green and Blue slid-
ers are now much closer to the Red slider’s value, as shown below:

In other words, the relative gamma values between the Red slider and the 
Green and Blue sliders have changed, because the Green and Blue sliders “bot-
tomed out” at 0% when you moved the Red slider to the left.

If you wish to instead preserve the relative gamma values of all three sliders in 
Ganged Mode, click to select Maintain Relative Values. When Maintain Relative 
Values is checked, DarkAdapted “remembers” the relative gamma values, 
even if one or more sliders reach the end of their travel.

The easiest way to understand the effect of Maintain Relative Values is to 
experiment with the control on and off. Make sure you set the sliders at 
greatly differing starting values to see the effect.

 In Ganged Mode, you may still temporarily move a slider indepen-
dently of the others. Simply hold down the SHIFT  or OPTION / ALT  key 
as you click on the desired slider, and you may move it without 
affecting the other sliders. 

 You may use your mouse’s scroll wheel to control the sliders in 
Ganged Mode. Simply position the mouse over the slider region 
and adjust the scroll wheel on your mouse. Note that scroll wheel 
support is a DarkAdapted Pro feature which requires registration.

The Gang Sliders and Maintain Relative Values settings are preserved when you 
quit and re-open DarkAdapted.

2.9 — Keyboard Control of Gamma Values
When any Control Window is active, you can press the TAB  key to numeri-
cally specify gamma values, entering those values via the keyboard. The 
Control Window is depicted below, as it appears after pressing the TAB  key:

Keyboard Control of Gamma Values

In the above illustration, note that the gamma value display to the right of the 
Red slider appears as editable text, and is selected. You may select the Green 
and Blue values by again pressing the TAB  key. 

 Holding down the SHIFT  key as you press TAB  selects the gamma value 
displays in reverse order. 

Once you have selected a gamma value for editing as described above, you 
may type in any valid gamma value between 0 and 255, or between 0% and 
100%, as described below:

•  If you type in a number without a percent sign (“%”), DarkAdapted expects a 
gamma value between 0 and 255. All displays will change to reflect gamma 
values, if they were showing percentages.

•  If you type in a number with a percent sign (“%”), DarkAdapted expects a 
gamma percentage between 0 and 100. If necessary, all displays will change 
to show gamma values as percentages.

 When you want to toggle between percentage and numeric displays, 
simply press the SPACE  key when editing any of the gamma value 
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displays. The display will alternate between the corresponding slider’s 
raw gamma value (zero to 255) and its percentage value.

When the gamma displays are displaying gamma percentages, and you press 
the TAB  key, only the numeric portion of the gamma percentage is selected, 
to speed keyboard entry, as shown below:

You may simply type the number portion of the percentage, and it will replace 
the selected text, leaving the percent sign (“%”) intact. If you instead wish to 
enter a raw gamma value between zero and 255, simply press the SPACE  key 
to toggle between percentage and raw value modes.

Once you have typed a gamma value, you can implement the change in one 
of the following ways:

•  press the TAB  key to select the next display, or
•  press RETURN  , ENTER  , or ESCAPE  , or
•  move the mouse, or
•  activate any other window.

Editing the gamma value displays to change between percentage and raw 
display values also changes the state of Report Gamma Values as Percentages in 
the Preferences Window.

 You may also move the sliders via the arrow keys. First, select the text 
to the right of the slider you wish to change. You may select the text by 
clicking in the text display, or by pressing the TAB  key.

 To move the selected slider to the right, hold down one of the modifier 
keys  , OPTION , or CONTROL  — and press the   or   key. To move it 
to the left, hold down one of the modifier keys  , OPTION , or CONTROL  
— and press the   or   key.

 If Gang Sliders is activated, you may move only the selected slider by 
using the OPTION  key modifier while pressing the arrow key. Otherwise, 
move all sliders in unison by holding down  or OPTION  while pressing 
the arrow key.

2.10 — Saving a Preset
Once you have defined a useful screen gamma value, you will probably want 
to use it again. DarkAdapted provides a simple method by which you may 
add as many presets as you desire. 

Add a preset by selecting Save Current Setting… from the Presets: pop-up 
menu (or by selecting Save Current Screen as Preset… from the File menu, 
or by typing S ). A window will then appear, where you may define a new 
preset or replace an existing one, as shown below:

Creating a Preset

If you would like to create a new preset, click the New Preset: button, then 
enter the desired name for the preset into the text field to the right of the 
button.

To replace an existing preset, click the Replace Preset: button, then select the 
existing preset that you would like to replace from the pop-up menu.

If, when you select this preset in the future, you would like to change the 
Control Window options Gang Sliders and Maintain Relative Values, click to 
select the checkbox labeled Selecting Preset Changes Options: Once selected, 
you may then toggle the state of the Gang Sliders control, and — when Gang 
Sliders is selected — also toggle the state of Maintain Relative Values. 

Click OK to add the preset to the Presets: pop-up menu, and to make it avail-
able throughout the program. If you wish to continue without adding the 
new preset, simply click Cancel to return to the Control Window.
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2.11 — Managing Presets
DarkAdapted gives you control over how your presets appear in the pop-up 
menu and throughout the program, and the program lets you delete, dupli-
cate, and rename presets that you have added to the program.

Presets may also be stored in disk files. If you have downloaded a presets file 
— or wish to load one of the sample files included with DarkAdapted — you 
may double-click the presets file or drag it over the DarkAdapted application 
icon to load its contents. You may also load a presets file from the Edit Presets 
Window, as described below.

 Since DarkAdapted does not attempt to modify your Windows 
registry, double-clicking a presets file may not load the file.

You may edit your presets by selecting Edit Presets... from the Presets: pop-up 
menu, by selecting Edit Presets... from the Edit menu, or by typing E . The 
Edit Presets Window appears, as shown below:

Edit Presets Window

Every preset that you have defined or imported from a file will appear in the 
scrolling list. Select all presets by choosing Select All from the Edit menu, or 
by typing A .

To change the name of any preset, select the preset by clicking on its name in 
the scrolling list, then edit the Preset Name: in the Selected Preset: area of this 
window.

The selected preset’s Color Values are also displayed here, with numbers 
between zero and 255 representing the values for the each color component 
(red, green, and blue). The displays for red, green, and blue are labeled R:, G:, 
and B: respectively.

You may change the red, green, and blue components of the selected preset 
by using the arrow controls to the right of each value.

The selected preset’s gamma color is also displayed visually in a colored 
square which appears to the right of the Color Values: control area.

You may also use your operating system’s Color Picker dialog to change the 
gamma hue; simply click on the colored square that appears to the right of 
the Color Values: controls.

It is also possible to specify that a preset can change certain Control Window 
options when the preset is selected. To specify that this preset should change 
the Control Window options Gang Sliders and Maintain Relative Values, click 
to select Preset Changes Options: Once selected, you may then toggle the state 
of the Gang Sliders control, and — when Gang Sliders is selected — also toggle 
the state of Maintain Relative Values. 

Duplicate an entry by selecting it and clicking Duplicate to save a copy of a 
preset under a different name.

Delete any number of presets by selecting one or more list entries, then 
click the Delete button (or press the DELETE  or BACKSPACE  key). The selected 
preset(s) will be deleted after a confirming dialog.

 You may skip the confirm deletion dialog by holding down the  
OPTION / ALT  key while deleting the entry as described above.

You may also change the order by which your presets appear in the Control 
Window’s Presets: pop-up menu. Simply click and hold on an entry, then drag 
it to the desired location in the listing.

You may also organize your presets by adding separators to your listing. 
Clicking the Separator button inserts a separator after the currently selected 
preset. If no preset is selected, a separator is added to the end of the listing. 

DarkAdapted does not allow the following actions: adding a separator when 
another separator is selected, exporting only separators to a file, renaming a 
separator, or duplicating a separator.
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The Actions: area of the Edit Presets Window offers several useful features, 
as described below

The pop-up menu labeled Perform Action… offers additional options when 
you click on the pop-up menu and hold down the mouse button, as depicted 
below:

The Perform Action Pop-up Menu

Select one of the options from this pop-up menu, as described below:

•  When at least one preset is selected, you may choose Save Selected Presets to 
File… to summon a save dialog, where you may specify a name and disk 
location for the presets file. Only the selected preset(s) (and separators, if 
any) will be saved to the disk file.

•  When one or more presets have been defined, you may choose Save All 
Presets to File… to summon a save dialog, where you may specify a name 
and disk location for the presets file. All presets and separators in the scroll-
ing list will be saved to the disk file.

•  When no presets have been defined, you may select Load Presets from File… 
to summon an open dialog, where you may select a presets file from any 
available disk. Any presets and separators in the disk file will populate the 
scrolling presets listing.

•  When one or more presets have been defined, you may choose Load Presets 
from File (append to list)… to summon an open dialog, where you may select 
a presets file from any available disk. Any presets and separators in the disk 
file will be added to the end of the scrolling presets listing, and will become 
selected.

•  When one or more presets have been defined, you may choose Load Presets 
from File (replace list)… to summon a file selection dialog, where you may 
select a presets file from any available disk. Any existing presets will be 
removed from the scrolling listing, and all presets and separators in the disk 

file will populate the scrolling presets listing, and will become selected. You 
may suppress the warning dialog by holding down the OPTION / ALT  key.

•  When at least one preset is selected, you may choose Delete Selection… to 
remove the selected presets and/or separators from the listing. A confirming 
dialog will appear, but you may suppress it by holding down the OPTION / ALT  
key.

•  When at least one preset has been defined, you may choose Delete All… to 
remove all presets and/or separators from the listing. A confirming dialog 
will appear, but it may be avoided by holding down the OPTION / ALT  key.

 When loading or saving presets files, the file selection dialog opens 
at the default presets file directory (folder). This folder is defined 
as being located in the same directory as DarkAdapted, containing 

“Presets” in the folder’s name. If no folder meets this requirement, 
DarkAdapted selects the first folder it may find containing presets 
files. You may override this behavior by holding down the SHIFT  
key while opening or saving presets files.

 Presets may optionally change the Control Window options Gang 
Sliders and Maintain Relative Values, as described earlier. By default, 
DarkAdapted does not include this information in files that it 
saves and loads. 

To save Gang Sliders and Maintain Relative Values information into 
your presets files, click to select Include Slider Options when Saving 
File — and then save the file as specified above.

To include any Gang Sliders and Maintain Relative Values informa-
tion that may be present in a presets file that you are loading, click 
to select Include Slider Options when Importing File — and then load 
the file as specified above.

When you are satisfied with the changes you have made in the Edit Presets 
Window, click the OK button to implement your changes, or click Cancel to 
discard all changes you made since the window opened.

2.12 — Preset Sets (Pro Only)
 Preset Sets are only available if you have upgraded to DarkAdapted 
Pro, or when you select Try DarkAdapted Pro… from the Special 
menu. To upgrade, select Register DarkAdapted Pro… from the 
Special menu.

 You may set global hotkeys for any Preset Set, so that the Preset 
Set can be accessed from anywhere on your computer, no matter 
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which application program is in front. Setting hotkeys is described 
in System-wide Menu Hotkeys.

In multiple-display environments, it is often useful to change all displays in 
unison. Preset Sets allow you to control up to six connected displays simul-
taneously.

For example, you may define a Preset Set that changes your primary monitor 
to bright red, and your secondary display to dark red.

Define Preset Sets in the Edit Preset Sets Window, which you may access  as 
follows:

•  Select Edit Preset Sets… from any Control Window’s Presets: 
menu, or

•  Select Edit Preset Sets… from the Edit menu, or 
•  Select Edit Preset Sets… from the System-wide Menu, or 
• Type SHIFT E

The Edit Preset Sets Window is depicted below:

Edit Preset Sets Window

Existing Preset Sets appear in the scrolling listing labeled Preset Sets (drag to 
reorder). Select a Preset Set by clicking on it. Select all Preset Sets by choosing 

Select All from the Edit menu, or by typing A . You may control the order 
in which Preset Sets appear by dragging the desired Preset Set to a new loca-
tion in the scrolling list.

Create a new Preset Set by clicking the New Set button. The new Preset 
Set will appear in the Preset Sets listing, and you may change its name and 
options in the Selected Preset Set: section of this window.

You may specify an option for each of up to six connected displays, using the 
pop-up menu that appears next to the desired display. Display 1 is your pri-
mary display (the one containing the menu bar), and you may define actions 
for up to give other displays, even if they are not presently connected.

For each display, you may select an existing gamma preset from each pop-up 
menu. You may also select No Change, which means that the desired display 
will be unaffected when the Preset Set is selected.

Preset Sets that you define will appear in most of the same places as regular 
gamma presets, namely:

•  In any Control Window’s Presets: menu, and
• In the System-wide Menu

Preset Sets do not appear in the Scheduling Window, however. There, you 
may apply a given preset to all monitors, or simply create separate events for 
each desired display.

You may drag Preset Sets to different positions, to change their display order. 
As with gamma presets, you may add a separator after the selected Preset Set 
by clicking the Separator button.

Delete one or more selected Preset Sets by selecting the desired Preset Set(s), 
then click the Delete… button (or press the DELETE  key). Skip the warning 
dialog by holding down the OPTION  key as you click the Delete… button or 
press the DELETE  key.

To save any changes you have made in the Edit Preset Sets Window, and to 
close the window, click the Save button. Click Discard to close the window 
without saving changes.

2.13 — Editing Preferences
To summon the Preferences Window, select the Preferences... menu item as 
described below, or type ,  (comma).

 Select Preferences... from the DarkAdapted X menu.
 Select Preferences... from the Edit menu.
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The Preferences Window will then appear, as depicted below:

DarkAdapted Preferences Window

The Preferences Window is where you can customize DarkAdapted to suit 
your tastes and requirements. There are several groups of controls in this 
window, and each group is pictured and described below.

Gamma Toggle Keys — Preferences Window

The Gamma Toggle Keys: section, depicted above, allows you to select which  
keys — when held down simultaneously — will return your monitor(s) to 
full brightness. Pressing the keys again will restore the previous gamma 
setting. Click the Define Gamma Toggle Keys… button to change the gamma 
toggle keys, and one of the following windows appears, depending on your 
computer’s operating system:

Set Gamma Toggle Keys Window — Macintosh

Set Gamma Toggle Keys Window — Windows

 Type any combination of modifier keys, plus the desired non-mod-
ifier key, to set the gamma toggle keys. Modifier keys are , SHIFT , 

OPTION , and CONTROL . Non-modifier keys are most other keys on 
your keyboard. At least one modifier key must be selected.

 Almost any Macintosh non-modifier key may be selected, includ-
ing function keys and many other keys on the extended keyboard. 
Note that the numeric keys that appear above the letters on your 
keyboard are not the same as the numeric keys on your numeric 
keypad. This gives you greater flexibility in defining hotkeys.
 Select any modifier key(s) by clicking to select the corresponding 
checkbox control, and type a non-modifier key to change the dis-
played key name. Modifier keys are CONTROL , SHIFT , ALT , and 

WINDOWS . Non-modifier keys are most other keys on your key-
board. At least one modifier key must be selected.

 DarkAdapted Pro may control multiple displays independently. If 
you have registered DarkAdapted Pro for Macintosh, and wish to 
have the gamma toggle keys control all displays in unison, click to 
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select Apply to all displays. Leaving Apply to all displays applies the 
Gamma Toggle Keys to only the frontmost Control Window.

Click OK to save the changes you made to the gamma toggle keys, or click 
Cancel to close the window without changing the key combination.

Gamma Fades — Preferences Window

The section entitled Gamma Fades: contains three controls:

•  The Steps: pop-up menu lets you control the speed of gamma transi-
tions. Selecting “1” will result in a nearly instantaneous gamma tran-
sition. The default value of “60” results in a gamma fade which lasts 
approximately one second.

•  Selecting the control labeled Sliders track gamma values during gamma 
fades causes the slider controls in the Control Window to move as their 
corresponding gamma values change.

•  Report gamma values as percentages controls how the current gamma val-
ues are displayed to the right of the Control Window’s gamma control 
sliders. When selected, the readouts are populated with percentage 
values between zero and 100%. When this control is deselected, the 
slider readouts report the gamma value as integers between zero and 
255. This controls display format only; functionality is not affected by 
this control’s setting.

Internet Update Checking — Preferences Window

The Internet Update Checking: section controls DarkAdapted’s version check-
ing functionality, as described below:

•  The Check for updates: pop-up menu controls whether DarkAdapted 
checks for updates manually, or automatically at a selectable inter-

val. Select Via “Special” Menu Only to check for newer versions of 
DarkAdapted only when you select Check for Program Updates… 
from the Special menu. If you select Every Week, DarkAdapted will 
check for a newer version every seven days. Selecting Every Month 
causes DarkAdapted to check for updates every thirty days.

•  To also check for newer alpha or beta versions of DarkAdapted, click 
to select Check for pre-release versions if available. Pre-release versions 
of DarkAdapted always check for such releases, regardless of this 
control’s setting.

Click the Check for Updates Now… button to immediately check for pro-
gram updates, which requires you to close the Preferences window.

 An Internet connection must be established in order for update 
checking to occur. If you use a dialup or other Internet connection 
that is not always available, we recommend selecting Via “Special” 
Menu Only from the Check for updates: pop-up menu.

More information regarding Internet update checking will be found at 
Internet Update Checking. 

DarkAdapted Pro Options — Preferences Window

When you have registered DarkAdapted Pro for Macintosh, the DarkAdapted 
Pro Options control group is enabled.

 DarkAdapted Pro Options are described below, and are only avail-
able once you register DarkAdapted Pro. To upgrade, select 
Register DarkAdapted Pro… from the Special menu.

•  If you want to avoid situations where your monitor becomes too faint to 
read, click to select Minimum Allowable Brightness. When this feature is 
selected, the brightness readout may be set to any value between 1 and 400, 
using the up and down arrow controls to the right of the readout. 

When activated, Minimum Allowable Brightness causes the Control Window’s 
gamma sliders to enforce the total brightness limit that you set here. Each 
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of the Control Window’s gamma sliders (red, green, and blue), may be set 
to a value between 0 and 255. When you adjust one slider downward, this 
feature automatically adjusts the other two sliders (if necessary) in order to 
maintain the minimum brightness you have set.

The Minimum Allowable Brightness that you set is checked using the sum of 
all three gamma sliders.

If DarkAdapted Pro enforces your minimum brightness, the Control 
Window’s R, G, and B labels become enclosed in parentheses — (R), (G), and 
(B) — as a reminder that the displayed value reflects the minimum allow-
able brightness.

•  If you would like DarkAdapted Pro to start every time you log in to your 
computer, select Open at Login. By default, DarkAdapted Pro configures 
your system so that DarkAdapted Pro opens at login, and remains visible. 
To instead hide DarkAdapted Pro when it opens at login, check both Open 
at Login and Hidden.

 A bug in Mac OS X 10.4.x (“Tiger”) prohibits the Hidden con-
trol from functioning. When using Tiger, you may open System 
Preferences  Accounts  Login Items to toggle the login visibility 
of DarkAdapted Pro.

•  If you would like DarkAdapted Pro to share its preference file, no matter 
who is logged in, select Share preferences between all users. When you first 
select this control, DarkAdapted offers to import any existing shared prefer-
ences, or to apply your current preferences to all users.

•  Show Dock icon controls whether DarkAdapted Pro appears in the Mac OS 
X dock. If you de-select this option, DarkAdapted will open without a dock 
icon the next time it is launched.

 If you de-select Show Dock icon and set System-wide menu to 
Hide, then your only interface to DarkAdapted Pro will be via 
its Control Window(s). To configure DarkAdapted Pro at the 
Control Window, right-click (or CONTROL -click) in a non-control 
area of the window, and a contextual menu opens with the choices 
DarkAdapted Preferences…, Show System-wide Menu…, and 
Quit DarkAdapted. You may use one of these to restore your user 
interface.

If you also set the preference to de-select Closing Control Window 
quits DarkAdapted, then there will truly be no interface by which 
to control DarkAdapted Pro. If this occurs, DarkAdapted Pro will 
present a dialog which offers to show the System-wide menu, or 
at least enable its hotkeys, so you have some means by which to 
control DarkAdapted Pro.

If you opt to enable hotkeys only — and you have defined no 
hotkeys for setting menu hotkeys and quitting DarkAdapted Pro, 
then DarkAdapted Pro will add those hotkeys for you and display 
them in a dialog.

•  The control labeled Show Control Window(s) when DarkAdapted Activates 
causes any hidden Control Windows to be shown when you return to 
DarkAdapted Pro from another application. To close Control Windows 
without quitting DarkAdapted Pro, make sure you do not select the prefer-
ence Closing Control Window Quits DarkAdapted.

•  The System-wide menu: pop-up menu allows you to control the visibility 
and behavior of DarkAdapted Pro’s system-wide menu ( ). Select Show to 
reveal the system-wide menu at the right side of your menu. Select Hide to 
prevent the system-wide menu from appearing. Selecting Hide, but enable 
hotkeys causes the system-wide menu to not appear, but its hotkeys (key-
board shortcuts) continue to function.

Miscellaneous Options — Preferences Window

The Miscellaneous Options: controls are described below:

•  Click to select Closing Control Window quits DarkAdapted if you want 
DarkAdapted to quit whenever any Control Window is closed (the 
default behavior). De-select this control to simply hide the Control 
Window using its close control. If you hide the window in this manner, 
you may again show it by selecting Show Control Window from the 
Special menu.

 Because closing the Control Window will leave you with no 
menubar on the Windows platform, Closing Control Window quits 
DarkAdapted is disabled on Windows.

 DarkAdapted Pro users who de-select Closing Control Window quits 
DarkAdapted may quickly re-show all Control Windows by hold-
ing down the SHIFT  key while clicking DarkAdapted Pro’s Dock 
icon in Mac OS X. To upgrade, select Register DarkAdapted Pro… 
from the Special menu.
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•  When the control labeled Restore previous gamma values on program 
launch appears with a checkmark, then DarkAdapted will store the 
state of all gamma sliders (and the Presets: popup menu, if applicable) 
when you quit DarkAdapted. The next time you launch DarkAdapted, 
the screen gamma will be returned to the saved values.

 When you reopen DarkAdapted — and its previous state was set 
to control displays independently, all displays will be returned to 
their previous gamma values when Restore previous gamma values 
on program launch is selected.

•  The Refresh gamma values every N seconds checkbox, when selected, 
causes DarkAdapted to re-implement your screen’s gamma settings 
periodically. This may be used, for example, to retain your preferred 
gamma setting when entering and/or exiting a screen saver, which will 
usually interfere with DarkAdapted’s settings. Use the small arrows to 
select a refresh frequency between 1 and 60 seconds.  

•  The control labeled Reset suppressed warning dialogs may be used to reset 
any warning dialog boxes that you have chosen not to display in the 
future, usually by selecting a Don’t show again checkbox or clicking a 
Suppress button in a dialog. If you click to select Reset suppressed warn-
ing dialogs, all suppressed warnings will again show after you save the 
preferences by clicking the Save button.

To implement any changes made in the Preferences Window, click the Save 
button, or click Discard to close this window without saving your changes. 

2.14 — The System-wide Menu (Pro Only)
 The system-wide menu is only available if you have upgraded to 
DarkAdapted Pro, or when you select Try DarkAdapted Pro… from 
the Special menu. To upgrade, select Register DarkAdapted Pro… 
from the Special menu.

When you first register DarkAdapted Pro (or when you select Try DarkAdapted 
Pro… from the Special menu), the system-wide menu ( ) automatically 
appears near the right side of your menu bar. You may choose to hide it by 
modifying the appropriate control in the Preferences Window.

The menu is illustrated below:

DarkAdapted Pro’s System-wide Menu

 You may set global hotkeys for any item in DarkAdapted’s sys-
tem-wide menu, so that any menu command can be accessed from 
anywhere on your computer, no matter which application program 
is in front. Setting menu hotkeys is described later in this section.

The various menu selections of the system-wide menu are discussed below.

If you have defined any Preset Sets (as described in Preset Sets), the first 
menu entry is labeled Preset Sets. When selected, a submenu opens where 
you may select any Preset Set that you have defined. The submenu also 
includes the command Edit Preset Sets…, which opens the Edit Preset Sets 
Window.

The next menu entry is labeled Presets. When selected, a submenu opens 
where you may select any of DarkAdapted Pro’s built-in gamma presets, or 
any preset that you have added. The submenu also includes the commands 
Save Current Screen as Preset… and Edit Presets…, which bring up the 
Save Preset Window and the Edit Preset Window, respectively. Saving pre-
sets and the managing presets are described in earlier sections.
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The next menu item, Show Control Windows, appears with a checkmark 
when at least one Control Window is open. Select this menu item to alter-
nately show or hide the Control Windows.

Selecting Show Brightness Slider causes the Brightness Window to appear:

DarkAdapted Pro’s Brightness Window

You may select to control all displays, or a single display, from the Display: 
pop-up menu. Pressing the D  key cycles between all connected displays, 
while pressing the A  key selects all displays. After you select from the pop-
up menu, the cursor moves to the brightness slider’s handle.

Moving the slider to the left dims the display, and moving it to the right 
brightens the display. This control retains the relative values of red, green, 
and blue on the selected display. 

The slider may also be moved using your mouse’s scroll wheel. Scroll up to 
increase brightness, or scroll down to decrease brightness. 

You may also move the brightness slider via the keyboard. To move the slider 
to the right, hold down one of the modifier keys  , OPTION , or CONTROL  
— and press the   or   key. To move the slider to the left, hold down one of 
the modifier keys  , OPTION , or CONTROL  — and press the   or   key.

 The window opens so that the slider’s handle appears under the 
mouse, unless doing so would cause the window to move partially off 
the screen, in which case the cursor is repositioned to appear over the 
slider’s handle. Thus, you will never need to reposition your cursor in 
order to start changing the brightness.

 Unlike the Control Window and the RGB Sliders Window, the 
Brightness Window displays the brightness percentage only; there is 
no way to toggle the display to show a “raw” brightness value. This is 
because there is no “raw” brightness value; the number of steps between 
zero and full brightness varies, depending on the screen gamma value 
when you first open the Brightness Window.

You may also type a numeric brightness value using the keyboard. Enter a 
valid number between zero and 100%, and the screen brightness will update 

when you press the TAB  , RETURN  , or ENTER  key. Pressing the ESCAPE  key 
updates the screen brightness and closes the Brightness Window.

 Some systems may prevent text entry in the Brightness Window, 
because some software additions and system revisions do not allow 
floating windows to receive the focus for entering text.

The control disappears when the mouse leaves the Brightness Window. To 
help you avoid accidentally closing the window, DarkAdapted waits until 
the mouse is at least 30 pixels outside of the window’s border before the 
window closes.

When you select Show RGB Sliders from the menu, the RGB Sliders 
Window appears:

DarkAdapted Pro’s RGB Sliders Window

You may select to control all displays, or a single display, from the Display: 
pop-up menu. Pressing the D  key cycles between all connected displays, 
while pressing the A  key selects all displays. After you select from the pop-
up menu, the cursor moves to the Red slider’s handle.

The controls in this window function identically to those in the Control 
Window, which was discussed previously; the R, G, and B sliders control the 
selected display’s red, green, and blue gamma values respectively, the Gang 
control functions identically to the Control Window’s Gang Sliders control, 
and the Maintain Relative Values functions identically to the control named 
Maintain Relative Values in the Control Window.

The sliders may be moved in unison using your mouse’s scroll wheel.

You may also move the sliders via the keyboard. First, select the text to the 
right of the slider you wish to change. You may select the text by clicking in 
the text display, or by pressing the TAB  key.  To move the selected slider to 
the right, hold down one of the modifier keys  , OPTION , or CONTROL  — and 
press the   or   key. To move it to the left, hold down one of the modifier 
keys  , OPTION , or CONTROL  — and press the   or   key.
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 The window always opens so that the red (top) slider’s handle appears 
under the mouse, unless doing so would cause the window to move 
partially off the screen, in which case the cursor is repositioned to 
appear over the slider’s handle. Thus, you will never need to reposition 
your cursor in order to start changing the sliders in ganged mode.

You may toggle the state of Gang by pressing the G  key on your keyboard. 
If Gang is active, you may also toggle the state of Maintain Relative Values by 
pressing the M  key.

You may also use your keyboard to type numeric gamma values, entering 
these values as raw values or as percentages.

As with the Control Window, you may press the TAB  key to alternately select 
red, green, and blue values sequentially (or select in reverse order by typing  

SHIFT  TAB  ).

 Some systems may prevent text entry in the RGB Sliders Window, 
because some software additions and system revisions do not allow 
floating windows to receive the focus for entering text.

Once a gamma value is selected, you may numerically specify gamma values 
using the keyboard. As with the Control Window, you may type a number 
without a percent sign to specify a gamma value between 0 and 255, and you 
may type in a number with a percent sign to enter a percentage. You may also 
press the SPACE  key to toggle between percentage and raw gamma modes.

When you change between raw gamma value and percentage display, all 
displays will change to show gamma values in the same format, and the state 
of Report Gamma Values as Percentages in the Preferences Window will also 
change, if necessary.

The screen’s gamma will update when you press the TAB  , RETURN  , or ENTER  
key. Pressing the ESCAPE  key updates the gamma and closes the RGB Sliders 
Window.

The window disappears when the mouse leaves the RGB Sliders Window. 
To help you avoid accidentally closing the window, DarkAdapted waits until 
the mouse is at least 30 pixels outside of the window’s border before the 
window closes.

If you have more than one display attached to your computer, the Display 
Control menu appears in the system-wide menu. In its submenu, you may 

select Control All Displays, or select the desired display number, as illus-
trated below:

DarkAdapted Pro’s Display Control Menu

The Display Control submenu is where you define which display will be 
affected by the menu commands Show Brightness Slider, Show RGB 
Sliders…, the brightness hotkeys (described in Setting Brightness Hotkeys), 
and any selection from the Presets submenu.

The Special menu in the system-wide menu contains several selections, as 
illustrated below:

DarkAdapted Pro’s Special Menu

The following items appear in the Special submenu:

•  The menu item About DarkAdapted Pro… brings up the About Window, 
which provides version and copyright information.

•  The three documentation-related menu items — DarkAdapted User Guide…, 
DarkAdapted Read Me File…, and License Agreement… — attempt to open 
these documentation .pdf files, if they can be located. DarkAdapted Pro 
expects to find these documents in the same folder as DarkAdapted Pro, 
or in a subfolder named “Documentation.” If located, DarkAdapted Pro 
attempts to open one of these documents using your default reader for .pdf 
files.
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•  Selecting DarkAdapted Web Site… opens your default web browser, and 
attempts to connect to our web site: www.darkadapted.com. You must be 
connected to the Internet, and your system must support automatically 
opening your web browser — in order for this command to function.

•  Select the menu item Send E-mail… to open your default e-mail client, pre-
addressed with our support e-mail address, and a subject line indicating 
your DarkAdapted version. In order for this to work, your system must 
support automatically opening your e-mail program

The Scheduling… menu item brings up DarkAdapted Pro’s Scheduling 
Window, as described in Scheduled Event Execution.

DarkAdapted can execute AppleScripts via the system-wide menu or via 
global hotkeys. The menu item AppleScripts… provides access to these 
scripts, and it is described in Running AppleScripts.

A menu item entitled Edit Menu Hotkeys allows you to set global keyboard 
equivalents for any menu item in the system-wide menu, as described in 
System-wide Menu Hotkeys.

The next menu item in the system-wide menu is labeled DarkAdapted Pro 
Preferences….  Select this item to open the DarkAdapted Preferences win-
dow, which is described in Editing Preferences.

Finally, the menu item Quit DarkAdapted quits the program.

2.15 — System-wide Menu Hotkeys (Pro Only)
 The system-wide menu ( ) and its associated hotkeys are only 
available if you have upgraded to DarkAdapted Pro, or when you 
select Try DarkAdapted Pro… from the Special menu. To upgrade, 
select Register DarkAdapted Pro… from the Special menu.

You may invoke any item in DarkAdapted Pro’s system-wide menu ( ) via 
global hotkeys. Global hotkeys are simply keyboard shortcuts that operate 
from within any application, as long as DarkAdapted Pro is also running. 

 System-wide hotkeys are available when you configure the system-
wide menu: preference in the Preferences Window to either “Show” 
or “Hide, but enable hotkeys.”

You may set system-wide hotkeys by selecting Edit Menu Hotkeys… from the 
system-wide ( ) menu. When you do so, the Edit Menu Hotkeys window 
appears, as pictured below:

Edit Menu Hotkeys Window

The scrolling listing contains two columns: Menu Command and Hotkey. The 
Menu Command column displays every menu item available in the system-
wide menu, along with the associated hotkeys in the Hotkey column.

Setting and editing hotkeys will be covered below.

If you have one or more hotkeys set up, and would like to clear the hotkey(s) 
so that no hotkey is activated for the desired menu command(s), simply click 
to select one or more entries in the scrolling list, then click the Clear Hotkey 
button.

The Discard button, when clicked, closes the Edit Menu Hotkeys window 
without saving any changes you may have made to the hotkeys. Click the 
Save button to save the hotkeys and close the window.

To set or change a menu command’s hotkey, do one of two things:

http://www.adpartnership.net/DarkAdapted/index.html
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•  Select the menu command in the scrolling listing, then click the Edit 
Selection… button, or

•  Double-click the desired menu command in the scrolling listing.

Once you perform one of the above actions, the Set Menu Hotkey window 
opens, as illustrated below:

Set Menu Hotkey Window

This window reminds you of which menu command you are currently edit-
ing in the display region that begins Current Hotkey for, followed by the sys-
tem-wide menu name. When the menu item is a submenu, its parent menu 
comes first, followed by “->” and the menu item itself.

To set a hotkey, press and hold the desired modifier keys ( , SHIFT  , OPTION   
and/or CONTROL  ), then — while still holding down the modifier keys — press the 
desired non-modifier hotkey. 

 Almost any non-modifier key may be selected, including function keys. 
Note that function key equivalents may not display properly in the sys-
tem-wide menu ( ), but they will function normally. This is a display 
issue that we are attempting to work around.

 Note that the numeric keys that appear above the letters on your key-
board are not the same as the numeric keys on your numeric keypad. 
This gives you greater flexibility in defining hotkeys.

After you have pressed the desired key combination, release the keys and 
observe the state of the red text display, which should correspond to the keys 
you just typed. When you are satisfied with your hotkey, click the OK button 
to close the Set Menu Hotkey window and return to the Edit Menu Hotkeys 
window. Click Cancel to close the window without changing the hotkey.

2.16 — Setting Brightness Hotkeys (Pro Only)
 The brightness hotkeys are only available if you have upgraded to 
DarkAdapted Pro, or when you select Try DarkAdapted Pro… from 

the Special menu. To upgrade, select Register DarkAdapted Pro… 
from the Special menu.

You may brighten or dim the selected screen(s) via global hotkeys. Global 
hotkeys are simply keyboard shortcuts that operate from within any applica-
tion, as long as DarkAdapted Pro is also running.

You may set up brightness hotkeys by selecting Edit Brightness Hotkeys… 
from the system-wide menu ( ). The Edit Brightness Hotkeys window then 
appears, as depicted below:

Edit Brightness Hotkeys Window

The Step: control at the bottom of this window defines the number of bright-
ness steps that DarkAdapted Pro uses when dimming or brightening the 
display(s). The number may be adjusted between 1 and 20 via the arrow con-
trols. A Step: of 1 produces a brightness change of about 0.4% per keypress, 
while a Step: of 20 produces a change of about 7.8%.

 Unlike DarkAdapted Pro’s other hotkeys, the brightness hotkeys 
repeat when you hold them down. The screen will continue to 
change in brightness until you release the brightness hotkey.

To set a hotkey for brightening or dimming the display(s), click the Set 
Hotkey… button in the controlling region matching the desired action (Hotkey 
to Brighten Selected Screen or Hotkey to Brighten Selected Screen). When you 
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click one of these buttons, the Set Brightness Hotkey window appears, as 
illustrated below:

Set Brightness Hotkeys Window

The text display that begins with “Current Hotkey” reminds you which bright-
ness hotkey you are editing. The red text displays the current brightness 
hotkey, if any.

To set a hotkey, press and hold the desired modifier keys ( , SHIFT  , OPTION   
and/or CONTROL  ), then — while still holding down the modifier keys — press the 
desired non-modifier hotkey. 

 Almost any non-modifier key may be selected, including function keys 
and many other keys on the extended keyboard. Note that the numeric 
keys that appear above the letters on your keyboard are not the same as 
the numeric keys on your numeric keypad. This gives you greater flex-
ibility in defining hotkeys.

After you have pressed the desired key combination, release the keys and 
observe the state of the red text display, which should correspond to the keys 
you just typed. When you are satisfied with your brightness hotkey, click 
the OK button to save your new hotkey and return to the Edit Brightness 
Hotkeys window. Click the Cancel button to close the Set Brightness Hotkey 
window without changing the brightness hotkey.

The brightness hotkeys will apply to whatever display you have selected 
using the Display Control command of the system-wide menu ( ), or — if 
the system-wide menu is not showing — the following displays:

•  The main display when Control Displays Independently (in the Edit menu) 
is selected.

•  All displays when Control Displays Independently (in the Edit menu) is not 
selected.

Click Save in the Edit Brightness Hotkeys window to save your brightness 
hotkeys and close the window. Click Discard to close the Edit Brightness 
Hotkeys window without saving any changes you may have made.

2.17 — Running AppleScripts (Pro Only)
 AppleScript execution is only available if you have upgraded to 
DarkAdapted Pro, or when you select Try DarkAdapted Pro… from 
the Special menu. To upgrade, select Register DarkAdapted Pro… 
from the Special menu.

DarkAdapted Pro looks for AppleScripts (with the .scpt extension) in a 
folder named AppleScripts, which must reside in the same folder that 
contains DarkAdapted Pro.

When one or more AppleScripts are located in this folder, an menu item 
named AppleScripts appears in the system-wide menu ( ). You may execute 
any AppleScript, from within any application, by selecting its name from the 
AppleScripts submenu.

 You may also define hotkeys that execute your preferred 
AppleScripts system-wide. Setting hotkeys for system-wide menu 
items is discussed in System-wide Menu Hotkeys.

2.18 — Independent Display Control (Pro Only)
 Independent display control is only available if you have upgrad-
ed to DarkAdapted Pro, or when you select Try DarkAdapted Pro… 
from the Special menu. To upgrade, select Register DarkAdapted 
Pro… from the Special menu.

By default, DarkAdapted controls all monitors using a single Control 
Window. To instead use separate Control Windows to control multiple 
monitors, select Control Displays Independently from the Edit menu (or type 

D ). This will open multiple windows, one for each connected display.

When in independent display mode, the Control Displays Independently 
menu item appears with a check mark next to it.

 If DarkAdapted Pro is set to not control displays independently, 
and a scheduled event specifies that a gamma fade should apply 
to a specific display, DarkAdapted Pro will automatically enable 
independent display control before executing the event.

DarkAdapted Pro saves the state of independent display control across 
launches.

2.19 — Scheduled Event Execution (Pro Only)
 Scheduled event execution is only available if you have upgraded 
to DarkAdapted Pro, or when you select Try DarkAdapted Pro… 
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from the Special menu. To upgrade, select Register DarkAdapted 
Pro… from the Special menu.

Many users desire gamma fading that operates on a schedule. For example, 
a planetarium operator may desire that DarkAdapted Pro dim the screen at 
the beginning of a show, or an air traffic controller may wish to brighten the 
screen at sunrise.

DarkAdapted Pro provides a flexible event scheduling mechanism, which 
is accessed via the Scheduling Window. The window may be activated by 
selecting Scheduling… from the Edit menu, or by typing G , in which case 
the Scheduling Window appears, as illustrated below:

Scheduling Window

The control labeled Enable Scheduled Events specifies whether DarkAdapted 
Pro should execute any events you have defined. When the control appears 
with a check mark, DarkAdapted Pro adjusts gammas according to your 
predefined schedule. To prevent scheduled events from executing, click to 
remove the check mark from Enable Scheduled Events.

Click to select Display 24-hour Time to display the time values in the 
Scheduling Window and Edit Event Window in 24-hour time, rather than 
am/pm time format. This control only affects the display of time, not the time 
of scheduled events.

All events you have defined will appear in this window’s scrolling display. 
You may select an event by clicking on the entry, or select multiple events by 
clicking while holding down your system’s multiple-selection modifier key. 

When one or more events are selected you may delete the selected event(s) 
by clicking the Delete… button. The events will be deleted after you confirm 
your decision in a dialog box, although you may skip the warning by holding 
down the OPTION  key while clicking Delete… .

To make a copy of the selected event, click the Duplicate button. The copy 
appears with a period and a number at the end, and is selected in the sorted 
list. You may then edit the copy as necessary.

You may edit an event by selecting a single event, then clicking the Edit… 
button. You may also edit an event by double-clicking on the event in the 
scrolling listing.

You may create a new event at any time by clicking the New Event… button, 
in which case the Edit Event Window appears, as illustrated below. The Edit 
Event Window also appears when you edit an existing event.

Edit Event Window

Type a descriptive name for the event in the Event Name: text entry field. 
DarkAdapted Pro will warn you if you attempt to add an event with the 
same name as an existing event.



Page 26 — DarkAdapted User Guide

If you wish for your event to control all monitors in unison, select All Displays 
from the Displays/Monitors: pop-up menu. To instead control only a single 
monitor, select the display number from the pop-up menu.

The Execute on Days: controls allow you to specify the days of the week that 
your event should execute. DarkAdapted Pro requires that you select at least 
one day of the week in order to save the event.

Click the On control to select all days of the week; click the Off control to dese-
lect all days. Drag either control over one or more days of the week to apply 
the desired action to every day of week control that you drag over.

 Dragging the On or Off control to the desired day(s) of the week 
eliminates repetitive mouse-clicking, which is especially useful if 
you are defining several events. For example, to select only the 
weekend days (Sunday and Saturday), click On to select all of the 
days (if necessary), then drag the Off control across the weekdays 
to turn them off.

The Event Time: region is where you specify the time of day that the event 
should execute. From the pop-up menu, you may select Time of Day, Sunrise, 
or Sunset.

•  When Time of Day is selected, a control appears wherein you may adjust 
the hour, minute, second, of the event. If you select 24-hour, the time will be 
displayed in 24-hour format; when de-selected, you may also click to adjust 
the am/pm indicator. When you click on the hours, minutes, or seconds region 
of the control, it begins flashing. When a value is flashing, you may use the 
arrow controls to adjust it upward or downward. The flashing ceases after 
five seconds, or when you click another region in the control.

•  When you select either Sunrise or Sunset, two controls appear. One is labeled 
Offset, and specifies how many minutes before or after sunrise/sunset the 
event should occur. You may adjust the Offset up or down by means of 
the arrow controls. So, for example, to define an event that will execute 30 
minutes before sunset, select Sunset from the pop-up menu, then click the 

“down” arrow control until the Offset reads “–30” minutes. The Offset may be 
adjusted in one-minute increments, with a minimum of –60 and maximum 
of 60 minutes. The Location control is explained below.

When you define an event as occurring based on sunrise or sunset time, 
DarkAdapted Pro requires your location on Earth in order to provide accu-
rate times. If you have never specified your location, the Location Window 
appears the first time you select Sunrise or Sunset from the pop-up menu. 
Thereafter, you may click the Location… button to change your location. The 
Location Window is depicted below:

Location Window

Your longitude and latitude may be obtained from an atlas, or via the Internet. 
Longitude is expressed in degrees and minutes; select West from the pop-up 
menu if your location is west of the Greenwich meridian (longitude increases 
as you move westward), or select East if your location is east of Greenwich 
(longitude increases as you move eastward).

Latitude is also expressed in degrees and minutes. Select North from the pop-
up menu if your location is north of the equator; otherwise, select South.

GMT Offset is the number of hours that your time zone differs from Greenwich 
Mean Time. This value will change throughout the year if you observe day-
light saving time. In most cases, it is best to select Obtain from Computer. You 
may also click to deselect Obtain from Computer and choose your offset manu-
ally from the pop-up menu, but be aware that choosing a manual adjustment 
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will not automatically compensate for daylight saving time, if observed in 
your locale.

Click OK to save your changes, or Cancel to discard them. If no valid location 
is specified, the Event Time pop-up menu in the Edit Event Window changes 
back to Time of Day. Closing the Location Window returns you to the Edit 
Event Window.

The Edit Event Window’s Screen Gamma: region is where you specify the 
gamma color that will be applied to the desired screen(s) when the event 
executes. You may select an existing preset via the Presets: pop-up menu, or 
define custom red, green, and blue values.

Clicking Select by Name forces DarkAdapted Pro to select the gamma color by 
its Preset name. This can be useful if you plan on replacing a preset (in the 
Edit Presets Window) with one with an identical name, but different color 
values. This saves the effort of redefining your events with different colors.

In most cases, however, it is best to leave Select by Name unchecked.

 If you delete a preset that is used by one or more scheduled events, 
DarkAdapted Pro will still be able to set the screen gamma to the 
deleted preset’s former values, unless you check the Select by Name 
option. This is why it’s best to leave Select by Name unchecked.

To save the changes you made in the Edit Event Window, click the OK button, 
and the window closes. To close the window without saving changes, click 
Cancel.

Scheduling Window

The various columns in the Scheduling Window include Name, which is 
simply the name you specified for the scheduled event in the Edit Event 
Window.

The Days column provides a visual representation of the days of the week 
on which the event will execute. Each entry in this column consists of seven 
characters, one for each day of the week, starting with Sunday and ending 
with Saturday. 

If a scheduled event will execute on a particular day of the week, the first let-
ter of the day’s name appears; otherwise, a hyphen (“–”) appears. So, an entry 
in the Days column of “S------” denotes an event that occurs on Sunday 
only; the entry “SMTWTFS” indicates that an event occurs every day; and an 
entry reading “---W-F-” denotes an event that occurs only on Wednesdays 
and Fridays.

The Time column will display either the event’s time of day, or that the event 
occurs at sunrise or sunset. If an event specifies sunrise or sunset, the offset 
(if any) in minutes appears here also.

The column titled Preset denotes the gamma preset applied to the event, if 
any. If the gamma value was specified manually in the Edit Event Window, 
the text “(none)” appears instead.

Color indicates the color that will be applied to the screen(s) when the event 
executes. If the Edit Event Window is used to specify Select by Name, as 
described above, the text “(select by name)” appears here, and DarkAdapted 
Pro will select the preset by its name when the event executes.

The Displays column indicates which display(s) will be affected by the sched-
uled event when it executes.

To save changes to the listed events, click the OK button, which also closes 
the Scheduling Window. Clicking Cancel closes the window, discarding any 
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changes made since the Scheduling Window last opened, including any 
changes made in the Edit Event Window.

2.20 — Internet Update Checking
DarkAdapted is able to check for newer versions, provided you have an 
active Internet connection.

 Many error messages are the result of an inactive Internet connec-
tion. Make sure you are connected to the Internet before attempt-
ing to use DarkAdapted’s Internet update checking.

To check for newer program versions, select Check for Program Updates… 
from the File menu.

If no update is required — DarkAdapted will present a dialog confirming 
that you are already up-to-date. If DarkAdapted determines that a newer 
version is available, the Update Window opens, as depicted below:

Update Window

Near the top of this window are listed the Version and Build Number for the 
currently-running copy of DarkAdapted (“Your Version:”) and for the Newer 
Version: available via the Internet.

The scrolling list may contain the latest changes in the new version, special 
instructions, program news, etc. The Copy command in the Edit menu may 
be used to transfer this text to another program.

Click the Download Newer Version button (at the bottom-right corner of the 
Update Window) to begin the download. A standard dialog will appear, 
where you may select the download destination and optionally change the 
download’s name.

Once the download begins, the two buttons Go to Downloads Page and 
Download Newer Version will disappear, replaced by a download progress dis-
play which reports the download’s status both numerically and graphically.

During a download, the Cancel button serves to terminate the download and 
close the window, after a warning dialog. When no download is in progress, 
clicking Cancel simply closes the Update Window. 

Click the Go to Downloads Page button to open your default web browser and 
display DarkAdapted’s downloads page.

When you click the Download Newer Version button, the version of DarkAdapted 
that matches your platform (Mac OS X or Windows) is automatically selected 
for download. To instead download DarkAdapted for a different comput-
ing platform, right click (Mac: control-click) in a blank area of the Update 
Window to summon the window’s contextual menu, as shown below: 

Update Window’s Contextual Menu

Select the desired version from the menu, then download the file to the 
desired location.

After successfully downloading an update, DarkAdapted instructs you to 
quit the program, expand the archive, and launch the new version to com-
plete the update process.

 You may force the Update Window to show — even if a newer ver-
sion is not available — by holding down the OPTION / ALT  key while 
you select Check for Program Updates… from the File menu. In 
such cases, some of the text in the Update Window will change, 
and the Download Newer Version button’s name will change to 
reflect the update server’s version.

2.21 — Custom System-wide Menu Icon (Pro Only)
 The system-wide menu is only available if you have upgraded to 
DarkAdapted Pro, or when you select Try DarkAdapted Pro… from 
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the Special menu. To upgrade, select Register DarkAdapted Pro… 
from the Special menu.

DarkAdapted Pro normally displays a small DarkAdapted icon ( ) to repre-
sent the system-wide menu. Experienced users may change this icon to, for 
example, match a particular menubar theme.

When launching, DarkAdapted Pro checks for a folder named “CustomIcon” 
(without the quotation marks) in the same folder as DarkAdapted Pro. It 
checks for the following two files inside the “CustomIcon” folder:

• DAIcon 
• DAMask

These two files should each be 16 pixels wide by 16 pixels high, and may 
include an extension (such as .jpg). If QuickTime is installed on your sys-
tem, DarkAdapted Pro can read most graphics formats. If QuickTime is not 
installed, only PICT files are supported.

The “DAIcon” file should contain your graphic of choice. The “DAMask” file 
should contain white pixels for any region that should be transparent, and 
black pixels for any region that should be visible.

Here are sample “DAIcon” and “DAMask” files — greatly enlarged — that 
represent the standard DarkAdapted Pro icon:

DAIcon DAMask

Here is a simple example of a “ball” icon:

DAIcon DAMask

Make sure that your images are exactly 16 pixels wide and high, that they 
are in a format that DarkAdapted supports, that you have named the files 
correctly (including the correct file extension), and that they are in the proper 
location, with a properly-named parent folder.
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Section 3:  
AppleScript Guide

3.1 — Introduction
 This section applies only to users running DarkAdapted for 
Mac OS X or Mac OS Classic. If you are using DarkAdapted for 
Windows, you may skip this section.

DarkAdapted contains extensive AppleScript support, allowing you to con-
trol almost every program feature and setting. This enables automated con-
trol of DarkAdapted from other programs or simple AppleScripts.

Additionally, you may obtain information concerning the current screen 
gamma, and store/retrieve preference settings.

A sample AppleScript is included with the standard DarkAdapted down-
load.

3.2 — Command Reference
The following tables summarize DarkAdapted’s AppleScript support. In the 
examples, the “¬“ character indicates that the script’s line wraps to the fol-
lowing line; do not include the “¬“ character in your script.

Command: activate

Syntax: activate

Function: Launches DarkAdapted if it is not already running, and brings the 
Control Window to the front of the window layering order.

Example: tell application "DarkAdapted"
 activate
end tell

Command: quit

Syntax: quit

Function: Quits DarkAdapted if it is running.

Example: tell application "DarkAdapted"
 quit
end tell

Command: savePreferences

Function: Saves all of DarkAdapted’s preference values, and the current 
gamma preset(s) or color values, for possible restoration with the 
restorePreferences command.

Example: tell application "DarkAdapted"
 savePreferences
end tell

Command: restorePreferences

Syntax: restorePreferences [parameter]

Parameters: with restoringGamma or without restoringGamma

Function: If  savePreferences has previously been called, all of 
DarkAdapted’s preference values are restored to their saved values. 
Use with restoringGamma to also restore the saved gamma 
setting(s) (or the saved preset(s), if selected).

Notes: restorePreferences has no effect if savePreferences has 
not previously been called. 

If you specify with restoringGamma, the most recently stored 
gamma setting or preset is restored. If the gamma has never been 
stored, it remains unchanged. 

Examples: tell application "DarkAdapted"
 restorePreferences with restoringGamma
 restorePreferences without restoringGamma
end tell
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Command: independentDisplayControl (DarkAdapted Pro only)

Syntax: independentDisplayControl [parameter]

Parameters: true or false 

Function: Specifies whether DarkAdapted Pro should control all displays in 
unison, or each display independently. Specify true  to control 
displays independently, with a separate Control Window for each 
display, or false to control all displays in unison, controlled by a 
single Control Window. 

DarkAdapted Standard simply ignores this command; it only works with 
DarkAdapted Pro.

Examples: tell application "DarkAdapted"
 independentDisplayControl true
 independentDisplayControl false
end tell

Command: selectDisplay (DarkAdapted Pro only)

Syntax: selectDisplay [parameter]

Parameters: An integer corresponding to one of your connected displays. 
Specify 0 for the main display,  1 for the second display, and so 
on.

Returns: boolean

Function: Set the desired display to control via subsequent AppleScript com-
mands, entering Independent Display Mode if necessary. If you 
specify a nonexistent display, the closest valid display is selected.

Setting the display to 1 or higher enables Independent Display 
Mode, if necessary.

This function returns false if a nonexistent display is specified, in 
which case DarkAdapted selects the closest valid display. Otherwise 
this function returns true.  

DarkAdapted Standard simply ignores this command; it only works with 
DarkAdapted Pro.

Examples: tell application "DarkAdapted"
 if not selectDisplay 0 then beep
end tell

Command: getGamma

Syntax: getGamma [parameter]

Parameters: with percentages or without percentages 

Returns: string

Function: Retrieves the gamma settings for the currently selected display in a 
comma-delimited string. 

If  with percentages is passed, the values are returned as per-
centage values, including tenths of a percent. 

If  without percentages is passed, values are returned in the 
range 0-255. 

The returned values represent the gamma’s red, green, and blue 
components, respectively.

Examples: tell application "DarkAdapted"
 if not setGamma preset "Full Brightness"¬
  then return -- sets the gamma to 100%
 display dialog getGamma with percentages¬
  -- displays "100.0,100.0,100.0"
 display dialog getGamma without percentages¬
  -- displays "255,255,255"
end tell
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Command: setGamma

Syntax: setGamma value [parameter]
or
setGamma preset [parameter]  

Parameters: If using setGamma value [parameter], the parameter must be 
passed as a comma-delimited string of the three integers which rep-
resent the desired gamma’s red, green, and blue components, respec-
tively. Each component value must be in the range zero to 255, with 
255 representing full brightness.

If using setGamma preset [parameter], the parameter must 
be passed as a valid preset name (as it appears in the Control 
Window’s Presets: pop-up menu).

Returns: boolean

Function: Implements a gamma fade on the currently selected display. Returns 
true if an allowable value or recognized preset is received, or 
false if an illegal value or unrecognized preset name is passed.

Notes: DarkAdapted will not allow the gamma value to be set to “0,0,0” — 
because a scripting error could also result in three zero-values being 
passed. To turn the screen off, use, for example, “0,0,1”

Examples: tell application "DarkAdapted"
 if not (setGamma value "255,255,255") then¬
  beep -- full brightness
 if not (setGamma preset "Full Green") then¬
  beep
end tell

Command: displayControlWindow

Syntax: displayControlWindow [parameter]

Parameters: with detailsShowing or without detailsShowing

Function: Use with detailsShowing to display the Control Window 
at full size, or use without detailsShowing to minimize the 
window.

Examples: tell application "DarkAdapted"
 displayControlWindow with detailsShowing
 displayControlWindow without detailsShowing
end tell

Command: gangSliders

Syntax: gangSliders [parameter]

Parameters: true or false

Function: Specifies whether or not the gamma control sliders move in unison 
when adjusting one slider. Specify true to gang the gamma con-
trol sliders for the selected display(s), or false to set the sliders to 
independent control.

Examples: tell application "DarkAdapted"
 gangSliders true
 gangSliders false
end tell

Command: maintainRelativeValues

Syntax: maintainRelativeValues [parameter]

Parameters: true or false

Function: Specifies whether or not the gamma control sliders maintain their 
proportions of red, green, and blue. Enters Ganged Mode if neces-
sary. Specify true to maintain relative slider values for the select-
ed display(s), or false to cause sliders to lose their relative values 
when one slider reaches the end of its travel.

Examples: tell application "DarkAdapted"
 maintainRelativeValues true
 maintainRelativeValues false
end tell

Command: restoreGammaOnLaunch

Syntax: restoreGammaOnLaunch [parameter]

Parameters: true or false

Function: Specifies whether or not DarkAdapted should restore previous 
gamma settings when it is launched. Specify true to restore previ-
ous settings at launch, or false to start up at full brightness.

Examples: tell application "DarkAdapted"
 restoreGammaOnLaunch true
 restoreGammaOnLaunch false
end tell
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Command: fadeSteps

Syntax: fadeSteps [parameter]

Parameters: 1, 15, 30, 60, 90, or 120

Returns: boolean

Function: Specifies the number of steps in gamma fades. Returns true if an 
allowable value is received, or false if an illegal value is passed.

Example: tell application "DarkAdapted"
 if not (fadeSteps 15) then beep
end tell

Command: toggleKeys

Syntax: toggleKeys [parameter]

Parameters: Any combination of two or more of the following: shift, 
control, option, alt, command, separated by commas.

Optionally, you may also pass keycode='X' and keytext='@Y' 
where X references the Macintosh hardware keycode (in decimal) 
for the desired key, and Y references either the character printed on 
the key or its ASCII value. 

If passing the ASCII value, precede the value by the @ character. 
You must pass both keycode and keytext , or neither.

Returns: boolean

Function: Specifies the modifier keys, and optionally changes the non-modifier 
key, that must be held down in order to toggle the gamma setting 
between full brightness and its last non-full value. Returns true if 
a successful command is received, or false if an illegal value is 
passed.

Example: tell application "DarkAdapted"
 if not (toggleKeys "shift, control, option")¬
  then beep -- just changes modifiers, not key
 if not (toggleKeys "shift,keycode='36',¬
  keytext='@13'then beep -- changes gamma ¬ 
  toggle keys to Shift + Return
 if not (toggleKeys "control,keycode='3',¬
  keytext='F'then beep -- changes gamma ¬ 
  toggle keys to Control + F
end tell
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Command: gammaToggleKeysAllDisplays (DarkAdapted Pro only)

Syntax: gammaToggleKeysAllDisplays [parameter]

Parameters: true or false

Function: Specifies whether or not the gamma toggle keys affect all displays, 
or only the display with the frontmost Control Window. Specify 
true to control all displays with the toggle keys, or false to 
control only the display with the frontmost Control Window.

DarkAdapted Standard simply ignores this command; it only works with 
DarkAdapted Pro.

Examples: tell application "DarkAdapted"
 gammaToggleKeysAllDisplays true
 gammaToggleKeysAllDisplays false
end tell

Command: gammaRefreshPeriod

Syntax: gammaRefreshPeriod [parameter]

Parameters: Integer in the range zero to 60.

Function: Specifies how often the screen gamma will be manually re-applied. 
Enter 0 (zero) to turn off gamma refreshing, or specify a period in 
seconds between 1 and 60.

Example: tell application "DarkAdapted"
 gammaRefreshPeriod 30
end tell

Command: doSliderUpdating

Syntax: doSliderUpdating [parameter]

Parameters: with trackingfades or without trackingfades 

Function: Controls whether sliders track gamma fades.

Examples: tell application "DarkAdapted"
 doSliderUpdating with trackingfades 
 doSliderUpdating without trackingfades 
end tell

Command: reportGammaValues

Syntax: reportGammaValues [parameter]

Parameters: with percentages or without percentages 

Function: Controls whether the text readouts (to the right of the gamma slid-
ers) report gamma values as percentages or as raw values.

Examples: tell application "DarkAdapted"
 reportGammaValues with percentages 
 reportGammaValues without percentages 
end tell

Command: updateChecking

Syntax: updateChecking [parameter]

Parameters: with prereleases or without prereleases 

Function: Specifies whether DarkAdapted checks for alpha or beta (“pre-
release”) versions when performing an Internet update check.

Examples: tell application "DarkAdapted"
 updateChecking with prereleases 
 updateChecking without prereleases 
end tell

Command: updateCheckFrequency

Syntax: updateCheckFrequency [parameter]

Parameters: One of the following strings: weekly or  monthly or via menu 
only

Function: Specifies whether and how often DarkAdapted performs an auto-
matic Internet update check for new versions.

Examples: tell application "DarkAdapted"
 updateCheckFrequency "weekly"
 updateCheckFrequency "monthly"
 updateCheckFrequency "via menu only"
end tell
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Command: hideSystemWideMenu (DarkAdapted Pro only)

Syntax: hideSystemWideMenu [parameter]

Parameters: with hotkeysEnabled or without hotkeysEnabled 

Function: Hides the system-wide menu, either with hotkeys enabled or with-
out hotkeys enabled.

DarkAdapted Standard simply ignores this command; it only works with 
DarkAdapted Pro.

Examples: tell application "DarkAdapted"
 hideSystemWideMenu with hotkeysEnabled
 hideSystemWideMenu without hotkeysEnabled
end tell

Command: showSystemWideMenu (DarkAdapted Pro only)

Syntax: showSystemWideMenu

Function: Shows the system-wide menu and enables its hotkeys.

DarkAdapted Standard simply ignores this command; it only works with 
DarkAdapted Pro.

Examples: tell application "DarkAdapted"
 showSystemWideMenu
end tell

Section 4:  
Troubleshooting

4.1 —  Error Messages in Windows
Some versions of Windows do not automatically adjust an application’s use 
of memory. If DarkAdapted exceeds the amount of RAM allocated to it, the 
program may display an error message, or it may crash. 

If you are running DarkAdapted X under Mac OS X, then this section is not 
applicable.

Many error messages are memory related, so — if you frequently encounter 
error messages, you may wish to allocate more memory to DarkAdapted. 
Consult your computer’s documentation as to how you may allocate more 
memory to an application program.

If you encounter error messages that you believe may be caused by an error 
within DarkAdapted, then take careful note of any error messages that appear, 
along with steps that lead to a reproducible error, and e-mail the information 
to us. We’ll do what we can to identify, reproduce, and correct the problem.

Make sure you have 2 MB available RAM in which to run DarkAdapted, espe-
cially if you have added many presets or scheduled events. DarkAdapted 
runs well under virtual memory and with most popular memory-doubling 
technologies.

If problems persist, try restarting in “safe mode,” as described in your com-
puter’s documentation.

4.2 — My Monitor is Stuck at Reduced Brightness!
This usually occurs if DarkAdapted or your system has crashed, leaving your 
monitor’s gamma ramp in a modified state.

First off, do not panic! It’s easy to restore your monitor to full brightness. 
 Simply restart your machine to return your monitor to its default 
gamma setting. If this is not effective, open your Display control panel 
and click the Settings tab. Change your Colors control to a different value 
and back again. As a last resort, try reinstalling your video driver to 
clear the “stuck” gamma preference.

 Under Mac OS X, select System Preferences... from the Apple 
menu. Select the Displays preference pane, then click on the Color 
tab. Click to select a different Display Profile, then select the original 
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(or any desired) profile to reset your gamma. If this does not work, 
you may have to restart your machine.

4.3 — Common Problems
Help! DarkAdapted no longer has an interface!

This can happen only when all of the following are true at the same time:

•  DarkAdapted Pro has been set to show no Dock icon (so that it has 
no menu bar at the top of your screen), and

• The preference for the system-wide menu is Hide, and

•  The preference Closing Control Window quits DarkAdapted has been 
set to false (de-selected), and

•  The last Control Window (which has a contextual menu allowing 
you to set preferences or show the system-wide menu) has been 
closed, and

•  You have forgotten the hotkey that shows the Edit Menu Hotkeys 
window.

If all of the above occur at the same time, DarkAdapted Pro warns you about 
a “no interface” situation, unless you have checked Don’t show again in the 
warning dialog the last time it appeared. At the very least,  DarkAdapted Pro 
enables system-wide hotkeys so that you can still control DarkAdapted Pro. 

There are four ways out of this situation:

•  Check out your “AppleScript” folder in your DarkAdapted folder 
for a script named “Restore Interface AppleScript.” Run this script, 
and all of DarkAdapted Pro’s Control Windows will show, and the 
system-wide menu will be enabled.

•   Try the default hotkey for Edit Menu Hotkeys… that DarkAdapted 
automatically sets up (if none is defined) when the interface disap-
pears. That hotkey is OPTION  K . That may open the Edit Menu 
Hotkeys window. You can then set a hotkey to show the Preferences 
window, and configure DarkAdapted Pro.

•   If you have defined a system-wide menu hotkey for Edit Menu 
Hotkeys…, and you can remember it, press that hotkey. You can 
then set a hotkey for the Preferences Window, and configure 
DarkAdapted Pro to your liking.

•  As a last resort, you can quit DarkAdapted Pro using Apple’s 
Activity Monitor (or simply log out and back in), then remove the 
DarkAdapted Preferences file from the Preferences folder inside the 

Library folder of your home directory, and remove the DarkAdapted 
Preferences file from the Preferences folder inside the Library folder 
at the top level of your startup disk, then re-open DarkAdapted and 
re-register.

DarkAdapted does nothing on my system.

This occurs most often with Windows-compatible machines. While 
DarkAdapted functions well with many Windows systems, it cannot sup-
port all possible hardware/software combinations. Generally speaking, if 
your hardware supports standard gamma change routines, DarkAdapted 
will work on it.

DarkAdapted doesn’t affect some of my screen colors.

Windows does not consider white when modifying gamma values. Some 
users have reported success via changing the Windows theme to the “Classic” 
value.

My gamma setting is not persistent.

Most systems will reset the gamma ramp when you restart, when a screen 
saver exits, or when your system sleeps and wakes. DarkAdapted will not 

“know” about this event and may not reset the gamma. The solution is to 
enable the Refresh gamma values control in the Preferences window.

DarkAdapted periodically shows the License Agreement window when I 
open DarkAdapted.

The License Agreement window appears the first time you open a new ver-
sion of DarkAdapted. If you open an earlier version, quit that earlier version, 
then open the newer version of DarkAdapted, the License Agreement win-
dow again displays. 

DarkAdapted contains several presets for Red and Green; why not Blue?

DarkAdapted was developed to help preserve the user’s dark adaptation. 
Red is most widely regarded as the best choice for this purpose, while green 
also has its adherents. Blue is not generally recommended to preserve dark 
adaptation, so no presets are supplied in the blue range.

If you’d like to add blue presets, check out the supplied file “Blue Presets,” 
which is part of the DarkAdapted download package.

DarkAdapted does not affect all of my monitors.

Version 1.3.1 introduced multiple monitor support. If you are using version 
1.3.1 or later, make sure you remove any prior versions of DarkAdapted, then 
restart your system to enable control of all connected displays.
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I upgraded to DarkAdapted Pro, but the menu still reads “DarkAdapted.”

Apple recommends against an application modifying the files that 
DarkAdapted would need to change in order to change the menu text. That 
is why we have added “DarkAdapted Pro” to the lower-left corner of all 
Control Windows, to the About menu items, and to each Control Window’s 
title.

DarkAdapted does not present the option “Try DarkAdapted Pro...”

If you are already trying DarkAdapted in Pro mode, this menu item will be 
unavailable. Note also that DarkAdapted Pro is only available to users run-
ning Mac OS X.

DarkAdapted does not present the option “Register DarkAdapted Pro...”

If you have already registered DarkAdapted Pro, this menu item will be 
grayed-out. 

If you are running Windows, note that DarkAdapted Pro is only avail-
able to users running Mac OS X, and so this command does not appear in 
Windows.

I receive error messages when I open the program.

If you are running DarkAdapted for Windows, then the first issue you should 
suspect is a memory problem. Try allocating more memory to DarkAdapted 
as described in your computer’s documentation or on-line help system.

It is also possible that the file “DarkAdapted Preferences” has become dam-
aged. In Mac OS X, “DarkAdapted Preferences” is located in the active User’s 

“Library” folder, in the “Preferences” folder. In Windows, the file is located in 
the same directory as DarkAdapted.

The preferences file must remain unlocked and in place while you use the 
program; otherwise, DarkAdapted will be unable to write preference infor-
mation, and an error message will be generated.

I receive error messages when I quit the program.

See the above discussion concerning the file “DarkAdapted Preferences.” 
Your startup disk must be writable (i.e., it cannot be a CD-ROM or other read-
only medium). Otherwise, DarkAdapted will be unable to save preference 
information when you quit the program, and an error message will appear.

I receive error messages while using the program.

If DarkAdapted reports an error while you are using the program, one of the 
following is likely to be true:

•  The program has run out of application memory. There isn’t enough 
memory to store additional data or display a graphic. This should not 
occur when running DarkAdapted X under Mac OS X, because Mac OS X 
dynamically allocates memory to application programs.

•  The program has attempted to write data to a disk that is locked or read-
only. This may occur when saving a file, when the program writes to its 
preferences file, or when writing temporary files to disk.

•  The program has attempted to access a file that has been moved or deleted 
since DarkAdapted last attempted to read from it.

•  The program contains an error that causes results that have not been antic-
ipated (a “bug”).

Make sure also that DarkAdapted and its support files are installed on an 
unlocked disk, and that you have started your computer from an unlocked, 
writable startup disk.

If you believe you have found a bug in the program, let us know! DarkAdapted 
contains many thousands of lines of programming code, and it is unrealistic 
for us to expect that we have anticipated every possible situation. If the situ-
ation is repeatable, please outline the steps that are required to reproduce the 
problem. Support information is described in the following Section.

4.4 — Technical Support
Consult the “Read Me” file in the Documentation folder — or click the link 
in DarkAdapted’s Control Window — for technical support contact informa-
tion.

Additional information is available at the DarkAdapted web site.

http://www.adpartnership.net/DarkAdapted/index.html


Page 38 — DarkAdapted User Guide

A

AppleScript
Command Reference  30
Running AppleScripts  24
Support in DarkAdapted  30

AppleScript Guide  30

B

Brightness Hotkeys  23
Brightness Slider  20
Brightness Window  20

C

Common Problems  36
Connecting to Our Web Site  5
Contents  3
Credits  5

D

DarkAdapted Pro
Features  6
Registering  7
Try for Free  6

Detail, Showing  9

E

Error Messages  35
Events, Scheduled  24

F

First Run  6

G

Gamma Values
Keyboard Control  11

Ganged Sliders  10
Guide Layout  5

H

Hotkeys. See also Keyboard Control
Brightness  23
System-wide Menu  22

I

Icon, Custom in System-wide Menu  28
Independent Display Control  24
Installation  5

K

Keyboard Control
Brightness Hotkeys  23
Brightness Window  20
Control Window Sliders  12
Gamma Values  11
RGB Sliders Window  20
System-wide Menu  22

L

License Agreement  4

M

Maintain Relative Values  11
Maximizing Control Window  9
Minimizing Control Window  10

P

Perform Action  14
Preferences  15

Check for Updates Now  17
Closing Control Window quits  18
DarkAdapted Pro Options  17
Gamma Fades  17
Gamma Fade Steps  17
Gamma Toggle Keys  16
Internet Update Checking  17

Minimum Allowable Brightness  17
Open at Login  18
Refresh gamma values  19
Report values as percentages  17
Restore previous gamma values  19
Share preferences  18
Show Control Windows  18
Show Dock icon  18
Sliders track gamma values  17
System-wide menu  18

Presets  8
Editing  13
Exporting  14
Importing  14
Loading  14
Managing  13
Replacing  12
Saving  12
Selecting  8
Sets  14

Preset Sets. See Presets

R

Registering DarkAdapted Pro  7
RGB Sliders  20
RGB Sliders Window  20

S

Scheduled Event Execution  24
Showing Additional Detail  9
Special Thanks  5
Stuck Gamma Setting  35
System-wide Menu  19

AppleScripts  24
Brightness Hotkeys  23
Icon, Custom  28
Illustrated  19
Preferences  18
Presets  19

Preset Sets  19
Show Brightness Slider  20
Show Control Windows  20
Show RGB Sliders  20

System Requirements  4

T

Table of Contents  3
Technical Support  37
Trademark Information  5
Troubleshooting  35

Common Problems  36

U

Update Checking  17, 28
Check for Updates Now  17

W

Web Site  5
What is DarkAdapted?  4

Section 5:  
Index

Alphabetical Index


	Section 1: Introduction
	1.1 — License Agreement
	1.2 — What is DarkAdapted?
	1.3 — System Requirements
	1.4 — Special Thanks
	1.5 — Trademark Information
	1.6 — Guide Layout
	1.7 — Connecting to Our Web Site

	Section 2: Installation and Setup
	2.1 — Installation
	2.2 — First Run
	2.3 — Try DarkAdapted Pro for Free
	2.4 — Registering DarkAdapted Pro
	2.5 — Selecting a Preset
	2.6 — Showing Additional Detail
	2.7 — Showing Less Detail
	2.8 — Ganged Sliders
	2.9 — Keyboard Control of Gamma Values
	2.10 — Saving a Preset
	2.11 — Managing Presets
	2.12 — Preset Sets (Pro Only)
	2.13 — Editing Preferences
	2.14 — The System-wide Menu (Pro Only)
	2.15 — System-wide Menu Hotkeys (Pro Only)
	2.16 — Setting Brightness Hotkeys (Pro Only)
	2.17 — Running AppleScripts (Pro Only)
	2.18 — Independent Display Control (Pro Only)
	2.19 — Scheduled Event Execution (Pro Only)
	2.20 — Internet Update Checking
	2.21 — Custom System-wide Menu Icon (Pro Only)

	Section 3: AppleScript Guide
	3.1 — Introduction
	3.2 — Command Reference

	Section 4: Troubleshooting
	4.1 — �Error Messages in Windows
	4.2 — My Monitor is Stuck at Reduced Brightness!
	4.3 — Common Problems
	4.4 — Technical Support

	Section 5: Index
	Alphabetical Index


